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Speedbar
If the option View Speedbar is selected, under the menu bar you will find a speedbar whose buttons have 
the following functions (from left to right):

group 1
empty page the same as File New
folder the same as File Open
disk the same as File Saven

group 2
+ 100 the same as Points Edit
levels the same as Edit Levels
scales the same as Edit Scales
section the same as Edit Section
colors the same as View Colors and lines
letter S the same as View Fonts

group 3
magnifier magnifier tool
question help tool
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File menu

This menu has the following entries:
New
Open
Save
Save as
Print
Exit
file list

For more information click on one of them.



Edit menu
This menu has the following entries:

Scaling
Measurements
Levels
Scales
Cross-Section
Copy

For more information click on one of them.



Points menu
This menu has the following entries:

Add
Edit
Go to
Caption

For more information click on one of them.



View menu
This menu has the following entries:

Points
Levels
Scales
Section
Colors and lines
Fonts
Statusline
Speedbar

For more information click on one of them.



Window menu
This menu has the following entries:

Tile
Cascade
windows

For more information click on one of them.



Help menu
This menu has the following entries:

Index
Using help
About Isolines

For more information click on one of them.



New (File menu)
Use this command in order to create a new file. 
The previous file is abondoned with an option to save changes. All windows of the old file are closed.



Open (File menu)
Use this command in order to read a previously created file from disk.
If you are already editing another file, this is erased with an option to save changes. Then the file open 
dialog    apears.

Keys:    CTRL+F12 



Save (File menu)
Use this command in order to save the active file. If the file is yet unnamed, the save as dialog appears 
instead. 
If you want save the active window as graphic, you have to use the command File Save as.

Keys: SHIFT+F12



Save as (File menu)
Use this command in order to save the active file with a new name or in a new directory or to save the 
active window as graphic.

Key: F12



Print (File menu)
Use this command in order to print the active window. Selecting this command make the printer setup 
dialog appear.
The width of the printing does not correspond to the width on the screen, but rather to the values given in 
the Scaling dialog.

Keys: CTRL+SHIFT+F12



Exit (File menu)
Use this command to exit Isolines. If you have changed the active file an option to save changes appear.

Keys: ALT+F4



file list (File menu)
Other entries in the file menu show the last edited files. You can use this option to open one of them.



Scaling (Edit menu)
Use this command in order to scale the diagram in the active window. When copying or printing the 
diagram the width corresponds to the values specified with this command.
Selecting this command makes the scaling dialog appear.

Keys: CTRL+M



Measurements (Edit menu)
Selecting this command makes the measurements dialog appear. You can specify there standard 
measurements for the x-y-coordinates and the measured values. These measurements appear in all 
dialogs where exist fields for coordinates and in the diagrams.



Levels (Edit menu)
Selecting this command makes the level dialog appear. There you can add or erase levels which are 
drawn in the diagram. You can also specify, wether the level lines have captions or not. 

In order to specify color and line type of the level lines you may use the command Colors and lines in the 
View menu.
For specifying the font of the caption you may use the command Fonts in the View menu.

Keys: CTRL+N



Scales (Edit menu)
Entering this command makes a dialog for specifying scale lines and frame lines of the diagram appear. 

In order to specify the font of scale captions you may use the command Fonts from the View menu.
For color and line style you may use the command Colors and lines from the View menu.



Section (Edit menu)
Use this command in order to create a cross-section through the measured field. Entering this command 
makes the Cross-section dialog appear.
After closing the dialog with <OK> a new window with the cross-section diagram is shown.
In order to erase a cross-section you may close the corresponding window.

In order to specify graphical details of the section you may use the commands of the View menu.

Scaling and Style of scales you can edit with the commands Scaling and Scales from the Edit menu. The 
edited window has to be active.



Copy (Edit menu)
Use this command in order to copy the diagram of the active window to the clipboard. From there you 
may paste the graphic to an other application with the command Edit paste of this application menu  e.g. 
Write, Word for Windows or an vector graphic program. You can embed a diagram in a text document for 
better presentation with caption and comments. You can also edit it with a vector graphic program such as
Corel Draw or Microsoft Draw which is in the Word for Windows bundle.

Keys: CTRL+INS oder CTRL+C

Alternative: 
You may also save the diagram as graphic with Windows Meta File formatby the command File 
Save as and import the graphic from disk to an other application.



Add (Points menu)
Use this command in order to add new measuring points. You will see a dialog for adding new points. For 
editing the given points you may use the command Points Edit. Fast change from Editing to Adding and 
back you get by double-clicking on the title bar of the dialog.

Keys: INS.



Edit (Points menu)
Use this command in order to edit or read the coordinates and measure values of the points added 
before. You get an edit dialog beginning at point number 1. 

In order to begin at another point you may use the command Points Go to. 
In order to add new points you may use the command Points Add.
Fast change from Editing to Adding and back you get by double-clicking on the title bar of the dialog.

Keys: CTRL+HOME



Go to (Points menu)
Use this command in order to edit or read the coordinates and measure values of the points added, 
beginning at an specified point. You get a go to dialog for specifying a point number. In order to begin at 
the first point you may use the command Points Edit.

Key: F4.



Caption (Points menu)
Use this command in order to choose one of varios kinds of point caption. You get a submenu with the 
following entries:

without the points appears in the diagram without caption
values the measure values are given at the points 
point-numbers the numbers of the points are given at them
coordinates the x-y-coordinates are given    at the points
extrema only the highest and lowest points have captions



Points (View menu)
Use this command in order to show or hide points in the diagram.



Levels (View menu)
Use this command in order to show or hide level lines in the diagram. You get a faster drawing, if the level
lines are hidden. That can be useful if you are editing other details of the diagram.



Scales (View menu)
Use this command in orde rto show or hide scales in the diagram.



Cross-sections (View menu)

Use this command in order to show or hide cross-section lines in the diagram.



Colors and lines (View menu)
Use this command in order to specify colors and line styles for scales, points and level lines.You get the 
colors and lines dialog.



Fonts (View menu)
Use this command in order to specify font type and font attributes for scales and level lines. You get the 
fonts dialog.



Frame (View menu)
Use this command in order to show a dialog for specifying frame with for editing the frame.



Status line (View menu)

Use this command in order to show or hide the status line.



Speedbar (View menu)

Use this command in order to show or hide the speedbar.



Tile (Window menu)

Use this command in order to arrange the windows side by side.



Cascade (View menu)

Use this command in order to arrange the windows overlapped.



other entries in the Window menu

Use this options in order to activate the coresponding window and show it over the others.



Index (Help menu)
Use this command in order to get the index of the Isolines help documentation. From there you will reach 
several helptopics.

Key: F1



Using help (Help menu)
Use this command in order to start the Windows helps system beginning at an introduction how to use 
Windows help system.

Information:
In order to get help about a menu command you may use the help tool. It shows a help cursor for 
entering help on a command by selecting this command in the menu.



About Isolines (Help menu)
This command shows a window with information about the programm and the adress of the author. With a
registration button you will get a registration form. With a help button you will get information about 
registration.



Open dialog
You will reach this dialog with the menu command File Open or the second button (from the left) of the 
speedbar. In order to get a filename you may follow the instructions below.

to get a directory:
If the file to open is not in the actual directory (The actual directory is given behind the word 
directory in the dialog), you may search it in the list box directories. By double-clicking on a 
subdirectory you will open it. Back to a superdirectory you will get by double-clicking on it. 
You may search the directory of the file to open in the tree of directories and open this directory by 
double-clicking on it.
You may also give the path to the directory direct before the filename in the file field. 

to get a filename
In the list box files all files with the extension .NVL in the actual directory are shown. If the file to 
open has another extension .XXX you may write the pattern *.XXX in the file field to get all files with
the extension .XXX, or *.* to get all files in the directory. Mark the file to open with the arrow keys or
the mouse and press the OK-button.
alternatively you may write the filename direct in the file field. 

Shorter: 
Open the file by double-clicking on its name in the files list box.



Save as dialog
You will reach this dialog with the menu command    File Save as or with the menu command File Save if 
you have created a new file.

You may follow the instructions below in order to specify a filename:

to select a format:
Normally you save a file with format NVL. This format is automatically selected. 
If you would like to export a diagram to another application you have to save it as graphic with 
Windows Metafile format.
Attention! A graphic contains not the hole filedata, but only one diagram and only graphical data. 
Thats why you cannot reimport the graphic as Isolines file. You should never save the diagram only
as graphic, but also with the NVL-format!
In order to save a diagram as graphic you may choose in the file typ box the format graphic (*.wmf).

to specify a directory:
You may search in the directories list box that directory which you want to save the file in. 
You will open a subdirectory by double-clicking on it. You will get back to a superdirectory    by 
double-clicking on it. The actually choosed directory is shown in the directory filed.
You may find the directory to save the file in in the tree of directories and open this directory by 
double-clicking.
Alternatively you may write the directory name direct into the filename field before the filenname.

to specify a filename
You may write the name oft the file to save into the filename field. If you dont write an extension, 
automatically the extension .NVL for owner format or .WMF for graphic format is added.

Exiting:
In order to exit the dialog press <OK>.



Print dialog

You will reach this dialog with the menu command File Print. You may select a printer, specify portrait or 
landscape and give more details by the options button.
After pressing the OK button the graphic of the active window is sent to the printer.



Printer setup dialog
This dialog should replace the dialog before in following versions of Isoline. In the print dialog then you 
may specify copy number, pages etc. for printing.



Scaling dialog
This dialog is for scaling the diagram. This does not correspond to the represantation on the screen which
can be scaled also with the magnifier tool. You will reach this dialog with the menu command Edit Scaling.
You may specify here values for scaling or width of the diagram. The measurement is the same as the x-
y-coordinates has. Read also the information about Measurement dialog. 



Measurement dialog
You will reach this dialog with the menu command Edit measurements. Here you may specify 
measurements for coordinates and measure values. This measurements will appear in several dialogs 
and in the captions of the diagram elements.

If you use polarkoordinates you may specify here only the measurement of distance. You will choose the 
angel measurement in the add- or edit dialog for points.

In the most of the dialogs you may give values also with the following measurements:

length: m, km, dm, cm, mm, dmm
angel: grd, gon, °

You should write those measurements behind the value, the application will transform the value to the 
standard measurement given in this dialog.



Levels dialog
You will reach this dialog with the menu command Edit Levels. Here you may specify which levels are 
drawn in the diagram

Range of values:
In the upper part of the dialog window you will see the minimal and the maximal values measured 
at points. The levels to draw should be between these values.

Caption
With the check boxes you may specify, wether the levels are captioned or not and if the 
measurement is written behind the level value.

To add a level:
You may write the value of the level in the level    field of the combobox and then press the Add 
button or the Enter key. The new level will appear in the list of levels.

To erase a level:
You may select the level to erase in the level list and then press the Erase button.

To exit the dialog:
You may press the OK button if the new levels should be calculated and drawn. In oreder to 
abandon the changes you may press the Cancel button.



Scales dialog
You will reach this dialog    with the menu command Edit Scales. Here you may specify details about 
scales and frame line.

Distance to points
In order to specify the distance of the scales to the proper parts of the diagram you may give here a
value from 0 cm to 1 cm.

Frame group
You may specify here, on which sides of the diagram are drawn a frame line. Linestyle and color 
will be specified in the Colors and Line dialog. 

Scale group
You may specify here, on which sides of the diagram scales are drawn. Linestyle and color will be 
specified in the Colors and Line dialog. 

Caption
You may specify the caption of the scales with the check-boxes.

Division group 
Here you may select between automatically and user defined division of scales. If you choose 
defined, you should write into the fields "start at" starting values and into the fileds step the 
distances for division.



Section dialog

You will reach this dialog with the menu command Edit Section or the button of the Speedbar with cross-
section on it.
You should write the coordinates of a starting and an ending point into the coresponding fileds and then 
press <OK>.



Points dialog 

You will reach this dialog with the menu commands Points Add, Points Edit, from the Go to point dialog or 
the button +100 of the speedbar.

This dialog has two modes: Add and Edit. A double-click on the title bar of the dialog toggles between 
the two modes.

In the Add mode you may add data of new points. You may write coordinates and values into the 
coresponding fields, skip in the number field to that position where you wish to insert the new point and 
then press the Add button or the Enter key.

In the Edit mode    you may look at or edit the data ofpreviously added points. You may go to any point 
with the number field and the arrow buttons left and right of it. You may write new values into the fields 
and then press the Change button or the Enter key to change the values. The changes are fixed and the 
dialog skips to the next point.

You may use different systems of coordinates: Cartesian coordinates and polar coordinates. 
Polarcoordinates may be given in grade or gon. You toggle between the systems by clicking on the button
right below. It shows a cross for cartesian ccordinates and a circle for polar cordinates. A number 300 for 
grade and 400 for gon.

You may use the small button on the right of the y-ccordinate in order to change the direction of angel. 
Plus is for science, minus for technical applications.

The button with the red cross servs for erasing or abandoning the specified data of the point.

The button with the letter i is for showing information about the ranges of the values.

The measurement field shows the standard measurment for the actual coordinate.

You may exit the dialog by the Close button if you want save changes, otherwise you may use the Cancel
button.



Go to dialog
You will reach theis dialog with the menu command Points Go to.

You may specify the number of the point you want to go to. After pressing <OK> you will see the Points 
dialog.



Fonts dialog
You will reach this dialog with the menu command View Fonts.

Here you may specify fonts and font attributes for the captions of scales/points and level lines.

The font heigths are given in decimillimeter. For level lines you should choose a low font height (ca. 30 or 
40 dmm is a good value).



Colors and lines dialog
You will reach this dialog with the menu command View Colors and lines or by pressing the color button of
speedbar.

Here you may specify colors for scales, level lines and points, in addition line thickness, line style for level
lines, shape and width for the points.

Thickness of lines you should give in decimillimeter. Width of points in centimeter.

Points may be drawn as cross, square or circle.



Frame dialog

Here you may specify the distance of the page margin to the diagram.
The value holds without scales, that is, you should give the distance betwwen the page margin and the 
points. The width of the scales depends from the font heigth and width. A normal width of scales is ca. 2 
cm. Thus you should give a value greater then 3 cm as frame width.



About Isolines dialog
Here you will find the adress of the author, the name and the version of the programm and copyright 
information. 
With the Registration button you will get a registration form, and with the help button you will get 
information about registration.



Using the mouse

The use of the mouse buttons depends on which mode is choosen. There are three modes: normal, 
magnifier and help mode. This modes are recognizable on the typical form of mouse pointer.

Normal mode

Besides the usual tasks of entering menu commands, manipulating scroller and window elements the 
mouse has two other usabilities:

Left mouse button:
If you are moving the mouse onto a point in the diagram, the mouse pointer alter from arrow to 
cross. That shows the ability to start the points dialog at this point by clicking on it.

Right mouse button:
By clicking of the right mouse button anywhere in the diagram range you may magnify it by the 
factor 1.5.
If you press the shift key during cliking the right mouse button you may reduce the diagram by the 
factor 0,67.
The clicked point rests in the window near to itself.

Magnifier mode

This mode is recognizable on the magnifier form of the mouse pointer, when it is moved in a diagram 
window. You will get this mode by clicking on the magnifier button in the speedbar. The left mouse button 
will get the same function as the rigth mouse button in normal mode.

Help mode

This mode is recognizable on the question sign form of the mouse pointer, when it is moved over the 
application menu. You will get this mode by clicking on the question sign button of the speedbar. In this 
mode you may enter a menu command to get help on this command.



Short keys
The most important menu command are reachable also by short keys. The combinations of keys you may
read behind the menu entry.

The shift key also servs for magnifying. You may read about this in Using the mouse.



How to create an isoline diagram

In order to create an isoline diagram you may follow the instructions below:

First you may enter the menu command Points Add. In the appearing dialog you may write one by one the
coordinates and measured values of the measuring points. Doing this you may choose a convenient 
coordinate system by the button with green cross or circle. You add the specified data of a point with the 
add button. You may abondon failed data by the button with a red cross on it.

After adding all points you may exit the input dialog, there will be opened a window which the added 
points are visible in as crosses.

Now you may enter the menu command Edit Levels. In the appearing dialog you may specify levels which
should be calculated and drawn. Obvious, this levels should be between the minimum and maximum of 
the measured values.

After exiting the dialog athe level lines are calculated and drawn. 

Now you may change the attributes of the graphic, such as fonts, line styles and colors, accordingly to 
your wishes. Finally you may print the diagramm, save it to disk or copy to the clipboard and import it into 
another application.



How to create a cross-section

In order to create a cross-section you may follow the instructions below:

First you may enter the menu command Points Add. In the appearing dialog you may write the 
coordinates and measured values of the measure points one by one. Doing this, you may choose a 
convenient coordinate system by the button with a green cross or circle. You may add the specified data 
of a point with the add button.You may abandon failed data    by the button with a red cross.

After adding all points you may exit the input dialog. Then a new window is opened which the added 
points are visible in as crosses.

Now you may enter the menu command Edit Section. In the appearing dialog you may give the cartesian 
coordinates of a beginning and an ending point of the cross-section. After exiting the dialog the cross-
section is calculated and shownin    a new window.

Now you may change the attributes of the graphic, such as fonts, line styles and colors, accordingly to 
your wishes. Finally you may print the diagramm, save it to disk or copy to the clipboard and import it into 
another application.



File formats
All data, such as points, levels, level lines, cross-sections and graphical options are saved in an Isolines-
own format. Usually the files of Isolines has the extension .NVL. Files of version 1.0 may be read if you 
are registrated as user of the version 1.0. But the version 1.0 cannot read files of version 1.1.!

Furthermore there exist the ability to save a level line diagram or a cross-section as graphic in the 
Windows meta file format. This is a list of Windows graphic instructions for a graphical device such as a
screen or a printer. This format is a standard and can be read by many applications. Thus you have the 
ability to embed diagrams created by Isolines in a document of another application or modify it by a 
graphic application such as Corel Draw or Micrsoft Draw.
A problem is the printing and screening of the slanting captions such as used for the level lines. Many 
applications and drivers don't present them as they are.

You may save a diagram as a Windows meta file in the clipboard with the menu command Edit Copy. In 
an other application you may use the menu command Edit Paste in order to import the graphic into this 
application.

Another way is the export of the Windows meta file to disk. In order to do this, you may enter the menu 
command File Save as and choose in the Save as dialog the file type grafik (*.wmf). You may import the 
saved graphic into another application by a command Import graphic or Insert Graphic. 

Attention! Isolines cannot read the Windows meta file format because it contains only graphical 
instructions. Thus you should never save a diagram only as graphic, but always also in the owner NVL-
format.



Problems and limitations

In principel all devices under Windows 3.1 should be capable to figure slanting True type and Adobe type 
fonts, but in test several printer drivers and graphic applications could not figure slanting fonts which are 
used to caption the levels in the diagrams.
A lot of laser printers can emulate more than one printer languages. If you don't get satisfactory results, 
you may test several emulations.

Ocasionally at scales may occur strange numbers near zero. Thats why I wished to use math 
coprocessor, but seams that real number types are not converted exactly. 
You may avoid this problems by defining scales by a convenient beginning value and step.

Only registered users of the version 1.0 has a version of the file OLDFILES.DLL, which is capable to read 
Isolines files of version 1.0. If you was working with that version you should register yourself to get 
support for the version 1.0. The more costs of that are only 5 DM. Also you don't forget register yourself 
for the version 1.1 to have support of this version in future. 



Suggestions for future versions
For the following version I have planed:
Abilities to import data as text and to export data as text and as DXF-drawing, better error handling, 
details.

Furthermore I wish to add the ability to work with layers (or strata), which may be shown one over on in 
cross-sections. And a third diagramm type should show the strata at one measuring point.

More, and more different graphical options. The ability of adding texts in the diagrams. More scale types, 
e.g. dials, crosses.

Depends on your reactions to this version, what capabilities the application get first, . Do not hezitate to 
send me your suggestions, ideas, problems and questions. You will find my address under Licence 
conditions.I will be thankful for any reply.



Licence conditions
You may copy and distribute this software without limitations, if you don't remove or change 
komponents of the pocket, that are especially the files ISOLINIE.EXE ISOLINIE.HLP, OLDFILES.DLL, 
MATH.DLL, REGISTRG.WRI, README.TXT, all examples, copyrights and resources.

You may test this software one month. If you want to use Isolines 1.1 after this testing period, you have 
to send a registration fee to the author. This registration fee is:
25 DM - for registered users of version 1.0: 
45 DM - for all other.

Registered users of version 1.0 further will get a version of OLDFILES.DLL, that can read files of version
1.0.

A registration has the following advantages: 
- You will get the following version of the programm automatically. 
- Updates are cheeper, 
- You will get help by the author, if you have troubbles or questions about the program and 
- You may give suggestions for further development of the program in a direction important for 

you.

You see, it is worth not forget a registration. 

For registration you may use the form REGISTRG.WRI. You may read, edit and print it with Windows 
Write. My adress is: 

Wolfram Diestel
Schmiedestr. 17
D-04416 Markkleeberg

my account:

Wolfram Diestel
Sparkasse Leipzig
BLZ: 860 555 92 (the code of the bank)
Acc.No.: 495 822 792
Germany

I wish you succesfully working with Isolines - Wolfram Diestel.



Registration

For registration you may use the form in REGISTRG.WRI. Its a Windows-Write file an may be shown, 
edited and printed by Windows Write. 
You will get it by clicking on the Registration symbol in the program manager or by the Registration button
in the About dialog.

You should also read the licence conditions and disclaimer.



Disclaimer

This software and accompanying written materials (including instructions for use) are provided "as is" 
without warranty of any kind. Furthermore the author does not warrant, guarantee, or make any 
represantations regarding the use, or results of use, of the software or written materials in terms of 
correctness, accuracy, reliability, currentness, or otherwise. All risks as to the results and performance of 
the software are assumed by you. If the software or written materials are defective you, and not the 
author or his dealers or distributors assume the entire cost of all necessary servicing, repair, or correction.
 
No oral or written information or advice given by the author, his dealers or distributors shall create a 
warranty and you may not rely on any such information or advice. You may have other rights wich vary 
from country to country. 

Neither the author of this software nor anyone else who has been involved in the creation, production or 
delivery of this product shall be liable for any direct, indirect, consequential or incidental damages 
(including damages for loss of business profits, business interruption, loss of business information and the
like) arising from the use of or inability to use such products even if the author has been advised of the 
possibility of such damages.




